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1. Introduction  

The national geological survey organisations of the UK, Ireland, France, Belgium, The 
Netherlands, Germany, Denmark, Norway, Sweden, Finland, Estonia, Latvia, 
Lithuania and Poland are working together to deliver the requirements of EC Tender 
MARE/2008/03. The geological surveys of Europe provide an existing network 
(through the Association of European Geological Surveys – EuroGeoSurveys) that 
aims to deliver marine geological information solutions to decision makers in 
European government and industry, as well as providing baseline information for 
academic research. The contract between the EC and the EMODNET-Geology project 
partners was signed on 16 July 2009; this interim report describes progress from July 
2010 to January 2011. 

2. Project objectives  

The EMODNET-Geology project is compiling information held by the project partners 
and additional datasets that are publicly available. The outputs will be delivered 
through the Web using the ‘OneGeology-Europe (1G-E)’ portal 
(http://www.onegeology-europe.org/). Existing metadata will continue to be stored 
on the EU-SEASED website, currently being developed and upgraded under the EC-
funded GeoSeas project (http://www.geo-seas.eu/). The consortium is bringing 
together datasets according to the ‘Preparatory Actions for European Marine 
Observation and Data Network Tendering Specification’, namely all available sea-bed 
sediments including rate of accumulation or sedimentation; sea-floor geology 
(including age, lithology and origin); geological boundaries and faults; rate of coastal 
erosion and sedimentation; geological events and event probabilities (to include 
information on submarine landslides, volcanic activity, earthquake epicentres); 
seismic profiles; minerals (including aggregates, oil and gas). The areas covered are 
the Baltic Sea, Greater North Sea and Celtic Sea according to the boundaries shown 
in Figure 1. 

 

Figure 1. Marine Regions and Sub-Regions as defined by the Marine Strategy 
Framework Directive.  
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3. Workplan and Workpackages  
 
The project is being implemented in four phases. Phases 1-3 are the Development 
phases and Phase 4 is the Maintenance phase.  
Phase 1. Development of the data layers and portal (months 1-12; July 2009-July 
2010)  
Phase 2. Testing and monitoring of the information layers (months 13-18; August 
2010- January 2011)  
Phase 3. Upgrade of the system following testing (months 19-24; January 2011-July 
2011)  
Phase 4. Maintenance of the system (months 25-36; August 2011-July 2012)  
 
The project is implemented through 11 workpackages, each led by organisations 
with experience in the specific fields.  These are: 
 
WP1. Project Management (British Geological Survey)  
WP2. 1:1 million marine geological data specification and sourcing (British Geological 
Survey).  
WP3. Sea-bed sediment information compilation and harmonisation (Geological 
Survey of Finland).  
WP4. Sea floor geology compilation and harmonisation (Bundesandstalt für 
Geowissenschaften und Rohstoffe (BGR) - Federal Institute for Geosciences and 
Natural Resources, Germany).  
WP5. Coastal erosion or sedimentation (TNO- Geological Survey of the Netherlands)  
WP6. Geological events and probabilities (Geological Survey of Norway).  
WP7. Minerals (Geological Survey of Ireland) 
WP8. Integration with OneGeology-Europe (including portal development) (British 
Geological Survey) 
WP9. Dissemination (British Geological Survey) 
WP10. Liaison with EMODNET lots (British Geological Survey).  
WP11. Project analysis and sustainability (British Geological Survey).  
 
Each of the data workpackages (WPs 3-7) consists of a development phase (October 
2009 to July 2010), upgrade phase (July 2010 to July 2011) and a maintenance phase 
(August 2011 to July 2012).  
 
3.1 Workpackage progress 
 
The objectives and description/deliverables as set out in the original tender are given 
followed by progress made in each workpackage. 
 
3.1.1. Workpackage 1. Project Management (British Geological Survey). 

Workplan objectives and deliverables 

Objectives: To manage the overall project, ensure delivery of the outputs and 
outcomes as agreed with the European Commission. To assess and evaluate the 
project and its results. 
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Description/deliverables: Provide leadership and co-ordination through the office of 
the Project Co-ordinator. Prepare, start up, organise, operate and close the project. 
Maintain all management documents and implement protocols. Control and monitor 
the project progress and to deploy the financial and staff resources effectively. 
Develop and maintain all project and quality plans, schedules and milestones. Report 
to the EC according the schedule specified by the Commission. Maintain 
communications across the consortium members and take overall responsibility for 
organisation of project meetings.  
 
The Project Co-ordinator will be assisted by a Steering Committee that consists of 
leaders of the Workpackages (some of whom may have responsibility for more than 
one WP).  
 
Project and Monitoring Meetings  

The project partners have met four times within the first 18 months of the project.  
 
12-13 October 2009 in Edinburgh, UK 
26-27 January in Rovaniemi, Finland 
14-15 June in Villefranche-sur-Mer, France 
26-27 January in Berlin, Germany 
 

These meetings were planned to co-incide with major project milestones. It is 
anticipated that there will be two further project meetings in September/October 
2011 to review progress during the maintenance phase and March 2012 to make 
plans for the sustainability of the project deliverables.  
 
3.1.2. Workpackage 2.  1:1 million marine geological data specification and 
sourcing (British Geological Survey). 
 
Workplan objectives and deliverables 

Objectives: To identify relevant data held by the project partners and other national 
organisations. Update the discovery metadata held on the EU-SEASED metadatabase 
(note that the seismic profiles layer (layer 6 of Geology lot) included in the tender 
documents section 2.3.1.5 will be derived from the EU-SEASED metadatabase). Audit 
existing national geological and value added spatial datasets (i.e. interpreted 
geological information). Define new Multilingual Geological Metadata Profile in 
accordance with the OneGeology-Europe project.  
 
Description/deliverables: Comprehensive audit and evaluation of national geological 
spatial datasets that can be compiled at 1:1 million scale in all partner countries. 
Evaluation of existing metadata profiles for description of geological datasets to 
provide a basis for a New Multilingual Geological Metadata Profile that will be 
defined and implemented through the OneGeology-Europe (1G-E) portal. 
  
Report on precision of data and how it has been processed. Where external data are 
used, this will be on the basis of freely accessible information that is in the public 
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domain. Should any agreements be necessary, these will be developed outside the 
EC project as these will be deemed to be in the national interest of each country. 
Any delay in provision of external data will not impact on the project deliverables, as 
the partners  
 
Progress 
 
Main data sources were identified during the Edinburgh meeting in October 2009 
and have been subsequently incorporated into the data workpackages. Further 
datasets have been incorporated as they become available to the project (see 
individual WP reports). A comprehensive list of geological metadata terms exists in 
the Multilingual Geological Metadata Profile, which will be updated with terms that 
are specifically related to marine geology.  
 
As part of the GeoSeas project, national geological surveys are now preparing CDI 
metadata entries and data files for their samples and cores. This is updating and 
increasing the range of marine geological and geophysical data established on the 
EU-SEASED metadatabases and making them available through dedicated GeoSeas 
portal. The locations and metadata will be made available as part of the CDI WMS 
and WFS services by which these can be added as an extra layer to the EMODNET-
Geology portal. The locations and metadata of the samples and cores can then be 
added to the seamless seabed sediment (and other) 1:1 million map layers for the 
European seas.   
 
3.1.3. Workpackage 3. Sea-bed sediment information compilation and 
harmonisation (Geological Survey of Finland). 
 
Workplan objectives and deliverables 

Objective: To compile and harmonise all available sea-bed sediment information at a 
scale of 1:1 million to deliver layer 1 of the Geology lot in the tender documents. 

Description/deliverables: Harmonisation of data will include an evaluation of the 
different classification schemes used in each country and the compilation of maps 
that integrate the datasets to the most appropriate scheme for integration with the 
hydrographic, chemical and biological lots. Where information on 
accumulation/sedimentation rates currently exists, they will be included in a 
separate report. A GIS layer will be delivered in the OneGeology-Europe portal.  
 
Progress 

Harmonisation of data from each country within the project area was completed in 
January 2010 as the substrate map was required for the EUSeaMap Project. The 
harmonisation methodology was reported in the July 2010 Interim Report. In the last 
6 months, the project partners have continued to work on the update of the 1:1 
million sea-bed geology map, in particular addressing any boundary mis-matches. 
The most up-to-date version of the map is given in Figure 2. 
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The WP is also compiling information on sedimentation rates where possible. As 
regional coverage of sediment rates is not available, the project partners are 
compiling data at point sources. This information is shown in Figure 4.  

One of the aims of the EMODNET-Geology project is to highlight data gaps and 
deficiencies, for example the low-resolution data on which many of the national 
geological interpretations are based. This is being achieved through the 
development if an Index Map (see Figure 3) and a GIS layer showing confidence in 
the interpretations (based on the data sources used to make the geological maps). 
These types of information are essential to allow users (and in particular decision-
makers) to understand the limitations of the maps.   
 

 
 
Figure 2. Sea-bed substrate map of the EMODNET-Geology Project study area. 
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Figure 3. Index map showing areas where sea-bed substrate data are available. 
The current version (January 2011) is a compilation of more than 200 maps. 

 
Sedimentation rates 
 
Project partners are compiling information also on sedimentation rates available in 
their national waters, including their EEZs. GTK has combined these data as shown in 
Figure 4. Data are currently available from the Baltic Sea and Greater North Sea, but 
these will be added to as new information is found in published sources.  
 

 
 
Figure 4. Sediment accumulation rates (cm/year) in the Baltic Sea/Greater North 
Sea. 
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Confidence assessment 

 
Feedback gained during national mapping activities and within the EMODNET group 
has shown that users of sea-bed geological information benefit from a confidence 
assessment of the map products. A number of complex system have been develop to 
assess confidence, however a system that has been developed in-house by the 
British Geological Survey has been discussed and agreed by the EMODNET-Geology 
partners as a good method for providing users with an easily understood assessment 
of the data providers confidence in their interpretations (see Appendix 1). These 
maps are being compiled during February 2011 to make available to other EMODNET 
projects (in particular the Broadscale Mapping Project – EUSeaMap) in time for them 
to integrate into their final report.  

3.1.4. Workpackage 4. Sea-floor geology compilation and harmonisation 

Workplan objectives and deliverables 

Objective: To compile and harmonise all available sea-bed geology (outcrop and sub-
Quaternary) information at a scale of 1:1 million.  
 
Description/deliverables: Compile all sea-bed geology maps available in each 
participating country and resolve any major boundary issues at 1:1 million scale. 
Information on age and lithology of the major stratigraphical units will be included 
(layer 2 of Geology lot – Section 2.3.1.5 of the tender documents). This workpackage 
and data layer will include the major geological boundaries and significant faults 
(layer 3 of Geology lot - Section 2.3.1.5 of the tender documents) that can be 
portrayed at 1:1 million compilation scale. A GIS layer will be delivered in the 
OneGeology-Europe portal.  

Progress 

WP4 is building on the the 1: 5 Million International Geological Map of Europe and 
Adjacent Areas (IGME 5000) compiled by Dr Kristine Asch of BGR, the WP4 leader.  

The IGME 5000 map delivered excellent harmonised data for the entire marine area 
of Europe at 1: 5 million scale. These data where compiled from the year 1995 to 
2005.  

For the EMODNET-Geology project, the IGME 5000 data are being adapted to 1:1 
million scale (IGME 1000) to provide an update and add more detail where possible 
at the more detailed scale (Figure 5). Any new terminologies will be adapted to the 
1G-E vocabulary. As well as adding the data layer to the 1G-E portal, the WP4 lead 
organisation (BGR) will consider printing a number of copies at their own expense to 
promote the map and the EMODNET programme.   

During the period since the last Interim Report (July 2010-January 2011), the 
EMODNET-Geology partners have reviewed the 1G-E vocabulary (for both and age 



EMODNET-Geology Project: January 2011 Interim Report 

 9 

and lithology). Subsequently, extracts from IGME 5000 maps have been produced for 
each country within the project area for review and up-date at the more detailed 
scale (Figures 6 and 7). 

Note that the WP4 data layer includes only pre-Quaternary geology. The project 
partners have agreed to include Quaternary information where possible – these data 
will not be harmonised as it is beyond the scope of the project, however they will 
provide a useful indication of the regional Quaternary information that is available 
and may form the basis for future collaborative project between the European 
geological surveys 

 

Figure 5. Sea-bed geology at 1:1 million scale. 
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Figure 6. Example of map showing the age  
of rocks (near Kristiansand, southern Norway). 

 

Figure 7. Example of map showing the lithology of rocks (near Kristiansand, 
southern Norway). 

3.1.5. Workpackage 5. Coastal erosion or sedimentation (TNO- Geological Survey of 
the Netherlands). 

Workplan objectives and deliverables 

Objective: To identify and map areas of erosion and sedimentation in the coastal 
zone of each participating country based on information available to the project 
partners, including publicly-available information (published scientific papers etc.) 

Description/deliverables: Compile all coastal erosion and sedimentation data 
available in each participating country and resolve any major boundary issues at 1:1 
million scale (layer 4 of Geology lot - Section 2.3.1.5 of the tender documents). A GIS 
layer will be delivered in the OneGeology-Europe portal. 
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Progress 

Coastlines can behave in three general ways: they can migrate seaward 
(progradation), remain in place, or migrate landward (retrogradation). Factors 
governing this behaviour are vertical crustal motion (uplift and subsidence), global 
(eustatic) sea-level change, sediment availability, wave and tidal processes, slope 
instability, and human-induced factors such as coastal-engineering and river-basin 
regulation works.  
 

 
 
Figure 8. Updated EUROSION database on coastal erosion and sedimentation. 
 
The purpose of WP5 is the compilation and merger of all coastline-behaviour 
databases held by or available to the project partners, and the visualization of these 
databases in an ArcGIS viewer. The central parameter in the final product will be 
(rate of) shore-normal coastline migration. To eliminate the impacts of short-lived 
and/or local events, average values over a period of 10 years are preferred. 
 
WP5 is carried out in four phases: 1) compilation of data on coastline migration in 
the appropriate format, 2) creation of a GIS file visualizing these data, 3) compilation 
of data on rates of coastline migration in the appropriate format, and 4) creation of a 
GIS file visualizing these rate data. 
 
The project group has made a start with the compilation of data on coastline 
migration. A GIS layer has been created, and the EUROSION database on coastal 
erosion and sedimentation is being supplemented and updated by the partners 
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(Figure 8). In the Netherlands, data on rates of coastline migration for the period 
1999-2009 have been compiled and are being transferred to GIS. 
 
EUROSION includes the most recent data for the UK, Germany, Latvia and Ireland. 
Updates will be delivered by the project partners from Estonia (date unknown), 
Finland (February 2011), Denmark (January 2011), France (Channel area, date 
unknown), Poland (quantitative data for final 20 years on the basis of maps and  
New data have been provided to the EMODNET-Geology project by the Lithuanian 
project partner (although there are still some problems with polyline continuity), and 
Belgium (with some problems transferring HW and LW lines to attribute values). 
There are no EUROSION data for Norway, however index and coastline migration 
shapes have been provided. 

Case study 

In the Netherlands, very detailed annual coastline migration data are available. In a 
case study of the Dutch coast, we show the added value of using high-resolution (in 
space and time) information. A worked example for one of the Dutch barrier islands 
will serve as a template for subsequent analyses (see Figure 9) 
 

 
Figure 9. Case study information from Ameland, the Netherlands. 
 
3.1.6. Workpackage 6. Geological events and probabilities (Geological Survey of 
Norway).  
 
Workplan objectives and deliverables 

Objective: To identify and map the locations of all significant geological events and 
provide information on probabilities of occurrence where available. These will 
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include sites of submarine landslides, and earthquake epicentres located in the 
offshore study  
 
Description/deliverables: Compile all information on geological events that are 
available in each participating country at 1:1 million scale (layer 5 of Geology lot - 
Section 2.3.1.5 of the tender documents). A GIS layer will be delivered in the 
OneGeology-Europe portal.  
 
Progress 
 
Key data holders for submarine landslide and earthquake information were 
identified and contacted during 2010. For submarine landslides, the main contact 
was partners of the EU-funded COSTA (Continental Slope Stability) project who have 
supplied a GIS file with outlines of the slide studied in this project. A template for 
attribute information based on the COSTA project database has been distributed to 
all partners, and has been completed by those partners who have slides to report. 
For earthquakes, three data centers have been contacted – Incorporated Research 
Institutes for Seismology, IRIS, United States, International Seismological Centre, ISC, 
United Kingdom,  and European-Mediterranean Seismological Centre, EMSC, France. 
Both the European centers have responded positively towards cooperation and 
supply of data. The European-Mediterranean Seismological Centre run a portal 
services, http://www.seismicportal.eu/jetspeed/portal/ with associated web 
services. At this first stage, static data has been supplied by EMSC. The current data 
coverage is restricted to earthquakes later than 1998, but will be increased in the 
near future. The EMSC are currently investigating the option to have their own WMS, 
but no time scale for this is available. Should their WMS service become available 
during the EMODNET-Geology project the EMSC data will be derived directly so that 
the most up-to-date earthquake information is available.   
 
A static preliminary web map services has been developed 
(http://www.ngu.no/mareano/Prosjekt/kart/jordskjelv.htm) (Figure 10), showing the 
location and magnitude of natural earthquakes since 1998. This is based on a fully 
populated GIS layer. Attribute information on date, time, depth and type of 
magnitude is available.  
 
For both submarine landslides and earthquakes, the deliverables are based on 
existing data compilations, supplemented by national data from the partners. For 
submarine landslides (Figure 11), the GIS information supplied by the former COSTA 
partners have been incorporated into ArcMap. The COSTA data has been updated by 
partners’ information e.g. in the North Atlantic. Small slides in, for example, the 
Norwegian fjords are shown as individual points. A preliminary web map services has 
been developed (http://www.ngu.no/mareano/Prosjekt/kart/jordskjelv.htm), 
showing the outlines and some attribute information. Information regarding the 
attributes for each slide are being tabulated e.g. area, age etc (Figure 12).  
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Figure 10. Screendump from the preliminary web map image provided by the 
ArcGisServer, showing the location of earthquakes provided by EMSC. The size of 
the circles indicate magnitude. 
 
 

 
 
Figure 11. Screendump from the preliminary web map image  showing the location 
of submarine slides. 
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Figure 12.Table showing the attributes of the submarine slides being compiled for 
WP6. 
 
3.1.7. Workpackage 7. Minerals (Geological Survey of Ireland) 
 
Workplan objectives and deliverables 

Objective: To identify and map areas of minerals (including aggregates, oil and gas 
and metalliferous minerals) in each of the participating countries based on 
information available to the project partners, including publicly-available 
information (published scientific papers etc.).  
 
Description/deliverables: Compile all mineral locations at 1:1 million scale (layer 7 of 
Geology lot - Section 2.3.1.5 of the tender documents). A GIS layer will be delivered 
in the OneGeology-Europe portal.  
 
Progress 

As reported in the bi-monthly progress reports, the WP leader has not been able to 
make rapid progress in compiling third party datasets due to lack of a response from 
organisations who have already compiled minerals data for the European seas. A 
template for gathering index data will be distributed to the project partners to compile 
all datasets that they are aware of and a layer will be added to the 1G-E portal by end-
May 2011.  
 
WP7 data differ from the other EMODNET-Geology layers in that they are mainly held by 
external organisations (e.g. Licensing Authorities). The WP leader will investigate ways of 
linking these data resources to the 1G-E site as this would give the user the most up-to-
date information available. A useful addition may be a summary of the licence 
agreements that are in force in each country within the project area, which could be 
compiled from the literature. 
 
Inclusion of data layers from published sources such as the Southern Permian Basin Atlas 
(as previously reported) are still under discussion, but it is expected that the distribution 
of e.g. oil and gasfields in the area will be made available to the EMODNET-Geology 
project. All available data layers for WP7 will be compiled by end July 2011. 
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3.1.8. Workpackage 8. Integration with OneGeology-Europe (including portal 
development) (British Geological Survey) 
 
Workplan objectives and deliverables 

Objective: To integrate EMODNET-Geology data layers in the OneGeology-Europe 
(1G-E) portal  to provide interoperable geological spatial datasets at 1:1 million scale 
for the offshore area included in the tender documents.  
 
Description/deliverables. In line with the deliverables and expected results of the 1G-
E project, the EMODNET-Geology products will deliver:  
1) public access to all interoperable geological spatial datasets 2) scientific and 
informatics specification for the harmonisation of geological data at 1:1 million 
resolution and progress towards a harmonised onshore-offshore geological dataset 
for the European Community 3) multilingual discovery metadata 4) a robust data 
model, schema and mark-up language for the geosciences, which is OGC compliant 
and documented and deployed across the EU 5) a web portal providing easy access 
to marine geological data 6) guidance on re-use of geological data 7) exchange of 
science, technology, informatics and communications skills across the EU. These 
deliverables will allow substantial progress towards INSPIRE goals – users will be able 
to discover, view and download geoscience data across the EU, which will also 
provide a template for other environmental data themes. The system will also 
provide a reference base on which other valuable data products and services can be 
built.  
 
The 1G-E web portal will also include an EMODNET-Geology project area that 
provides: 
  
1) on-line instructions allowing users to understand and download the data 2) 
indications of the precision of the data 3) project progress. The first operational 
version of the portal will be ready by the end of Phase 1 (Month 12).  
 
Progress 

The EMODNET-Geology web page is now available (Figure 13) and provides links to 
the OneGeology-Europe portal which is being used to deliver the EMODNET-Geology 
map layers as well as providing links to the other EMODNET portals. The domain 
‘emodnet-geology.eu’ has been purchased for use by the project and will be 
implemented as part of the next release of the website during the week 
commencing 7 February 2011. 
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Figure 13. EMODNET-Geology web page. 
 

 
 
Figure 14. Sea-floor geology (WP4).  
 
The map layers for sea bed sediment (WP3) and sea floor geology (WP4; Figure 14) 
are now available via the 1G-E portal. Each map layer also includes metadata (Figure 
15) detailing access constraints, the location of the WMS which is hosting the 
individual map layer, contact details and coverage information. 



EMODNET-Geology Project: January 2011 Interim Report 

 18 

 

 
 
Figure 15. Metadata for the EMODNET-Geology substrate map. 
 
Map layers for Coastal Behaviour (WP5) and Geological Events (WP6) are now 
complete and will be delivered as a WMS. These will be made available via the 1G-E 
portal as soon as the necessary local OGC complaint WMS services have been 
initiated at the partner organisations responsible for the compilation of these map 
layers.  
 
Work has also now started to implement additional functionality for a number of the 
map layers using the WFS services. This will include the use of the GeoSciML for the 
lithological and stratigraphical map layers, and Quake ML mark-up language for the 
geological events and probabilities. (GeoSciML is the XML geosciences standard 
which is being implemented by 1G-E for the purposes of delivery of geological map 
data.) 
 
The WMS map layers currently being delivered in the 1G-E portal will also be 
delivered via the One Geology (global) portal. As a result the map products will reach 
the wider global One Geology community which extends beyond Europe. 
 
Refresh speed 
 
The speed of refresh is currently slow because each map in the portal is being served 
from a different local server and is dependent on the speed of the map service  
provided by the partner that is hosting that map layer. For example, in the case of 
the onshore geology, each country is hosting its own part of the harmonised map 
which is why the map appears country by country.  The feedback from the 
Commission and MODEG that there is a requirement to speed up the refresh rate for 
the EMODNET Geology map layers would require that we move away from the 
distributed approach used by OneGeology-Europe for the terrestrial geology and 
host all of the map layers on one server. There are disadvantages to this approach, 
the most significant being that if the service goes offline all of the map layers 
become unavailable. In keeping with most web-based data systems there are no 
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specific targets for loading times, however there are plans to address the issues 
regarding the intuitive use of the EMODNET-Geology data layers.  
 
Access to marine data layers in 1G-E portal 
 
As stated in the bid documents, the intention of the EMODNET-Geology project was 
to make all of the marine map layers available in the 1G-E portal. Feedback from the 
Commission and MODEG indicates that the system is not intuitive to use. One of the 
advantages of using 1G-E was considered to be that users of information would be 
given access to both offshore and onshore geological information in one place and 
so there was no intention to separate these into a marine part and a land part. 
However, the 1G-E portal does show those products that are developed within the 
EMODNET-Geology project.  
 
To address the feedback, we consider there to be two options. One is to ‘re-skin’ the 
1G-E portal for EMODNET Geology and deliver only the EMODNET Geology map 
layers. To do this will require a transfer of budget to our French partner BRGM as 
they are responsible for development of the 1G-E portal. The second option is to 
develop a portal similar to the other EMODNET lots in look and feel, that is based on 
open-source principles. Our preference is to do the latter as this would allow both 
the EMODNET-Geology project partners and external users to adapt the portal to 
their own local requirements. Both of these options will require the Project Co-
ordinator to investigate availability of appropriate staff. A schedule for this work will 
be presented once a decision has been made on the best approach. 
 
Multilingual geological metadata 
 
Within the 1G-E portal, there is a  multilingual geological metadata profile. The  
metadata profile is based on the international EN ISO 191 series of standards for 
geographic information. It is also fully compliant with developing INSPIRE directive 
implementation rules for metadata. The marine geological terms that are being 
introduced into 1G-E will follow the same system for a web-based multilingual 
metadata catalogue (OGC, ISO compliant) and metadata entry system for geological 
and applied map datasets. The metadata catalogue will be provided in at least 
English, French, German, Norwegian, Danish, Finnish, Swedish, Dutch and Polish with 
the possibility to extend this set of languages. The multilingual metadata will be 
delivered by the end of July 2011.  
 
 
Integration with other EMODNET Lots 
 
The EMODNET-Geology project is also using the web map services (WMS) from the 
other EMODNET lots in order to display related map layers. For example Figure 16 
shows a habitat maps created by EUSeaMap overlain on the EMODNET-Geology sea- 
bed substrate maps viewed in the 1G-E portal.  
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Figure 16. EUSeaMap habitat data viewed in the One Geology-Europe portal. 
 
3.1.9. Workpackage 9. Dissemination (British Geological Survey). 
 
Workplan objectives and deliverables 

Objective: To ensure widespread dissemination of the EMODNET-Geology products, 
through targeted contact with stakeholders and other users of marine geological 
information. 
 
Description/deliverables: The main focus for dissemination will be the 1G-E portal, 
which by integration with EMODNET-Geology will ensure maximum exploitation of 
dissemination opportunities. 1G-E has already received major publicity (TV and press 
media) and has an extensive campaign of events planned during the project. The 
EMODNET-Geology partners will bring their specialist knowledge of the users of 
marine geological data to this effort and will deliver their own dissemination 
objectives through participation at national and international meetings, workshops 
and conferences that focus on marine science. Factsheets and PowerPoint 
presentations on the specific deliverables of the EMODNET-Geology project will be 
delivered. Collaboration with other initiatives (see Workpackage 10), will further 
ensure widespread dissemination. 
 
Progress 
 
The EMODNET-Geology project was included in three separate presentations and a 
poster at the ‘Geoscience 2010’ meeting in Dublin, Ireland (November 3-4, 2010). 
The EMODNET-Geology project was mentioned in the opening remarks by Maria 
Damanaki, the Commissioner for Maritime Affairs and Fisheries, during the EurOcean 
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2010 Conference in Ostend, Belgium on October 12 2010. EMODNET-Geology was 
also included in a presentation at the GEO (Group on Earth Observations) Ministerial 
Summit in Beijing, China from 3-5 November. The project was part of the 
EuroGeosurveys contribution to an exhibit organised by the EC, which also included 
ESA and Eumetsat. A book entitled ‘Crafting Geoinformation’ included the 
OneGeology project and the offshore information being provided by EMODNET-
Geology. The book can be downloaded at: 
http://www.earthobservations.org/documents/geo_vii/geo7_crafting_geoinformation.pdf 
 
The EMODNET-Geology project was presented at the Baltic Sea Geology Conference 
in St Petersburg by Anu Kaskela of the Finnish Geological Survey. 
 
* Note all international presentations were at the expense of individual partners and 
did not incur costs to the EMODNET-Geology project.  
 
3.1.10. Workpackage 10. Liaison with EMODNET lots (British Geological Survey).  
 
Workplan objectives and deliverables 

Objective: To ensure that the EMODNET-Geology project is fully aware and 
complementary to the objectives of other marine science initiatives within European 
waters. To prepare for better and linked marine data that will have an immediate 
impact on the planning of environmental policy and mitigation measures within the 
European Union and to facilitate impact assessments and scientific work.  
 
Description/deliverables: To be defined with other project co-ordinators and 
groups/projects, however at a minimum level to support the aims of the EU Blue 
Book on an integrated maritime policy for the European Union and the 
accompanying Action Plan. By providing an overview of the main data and 
information resources available and the benefits and added value of integration, the 
workpackage will contribute to proposals for the development of mutually 
compatible and multi-dimensional mapping of seas in the Member States waters.  
 
Progress 

In the early stage of the project, the principal liaison with other EMODNET lots was 
with the EUSeaMap project to deliver the Sea-bed substrate map described in WP3 
by an agreed deadline of January 2010. Feedback from the EUSeaMap was taken 
into account during further development of the WP3 data layer. Note that the 1G-E 
system is able to integrate the EUSeaMap data using WMS as reported in the 
previous section (see Figure 16). The sea-bed sediment maps in relation to the 
Broadscale Habitat Mapping project were presented by David Connor during his 
presentation at the EurOcean 2010 Conference in Ostend, Belgium.  

As previously reported, awareness of other projects and their complementarity to 
EMODNET is provided by the EMODNET-Geology project partners themselves as 
many have participated, or are participating in a number of other geological 
initiatives; these include the MESH Project – TNO (Sytze van Heteren) and BGS; 
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BALANCE - GEUS (Jørgen Leth) and GTK (Aarno Kotilainen, Ulla Alanen and Anu 
Kaskela); EU-SEASED - all partners were involved in the EUMARSIN and EUROSEISMIC 
projects; Geo-Seas - BGS (Helen Glaves: Project Co-ordinator); BLAST (Bringing Land 
and Sea Together) - BGS (Alan Stevenson); OneGeology-Europe - BGR (Kristine Asch). 
Several of the partners are from organisations involved in leading their national 
multidisciplinary mapping programmes such as INFOMAR (Geological Survey of 
Ireland), MAREANO (Geological Survey of Norway) and MAREMAP (British Geological 
Survey).   
 
The project co-ordinator and partners continue to liaise when necessary with other 
EMODNET lots.  

Appendix 1.  

A Simple Confidence Grid for the EMODNET-Geology Sea-bed substrate Map 
 
An ESRI Arc grid (1km cell) is created to represent a level of confidence in assessing 
the seabed sediment at a known location. The grid has a numerical score of 0 to 8, 
from a low to higher level of confidence. Confidence has been assessed only in terms 
of easily quantifiable parameters. The score is based upon data availability/density 
and equipment type. No allowance has been made for positional accuracy due to the 
resolution of final grid cell size.  
 
The following is a brief outline of the stages used to develop the grid, with a final 
value of between 0 and 8. Each stage below results in an intermediate grid, with an 
appropriate score, that are then summed to produce the final confidence grid. 
THIS IS A SIMPLE AND EASY ATTEMPT TO VISUALIZE CONFIDENCE FOR A REGIONAL 
SCALE (1:250000) IT DOES NOT TAKE HETEROGENITY/VARIABILITY OF SEA-BED 
SEDIMENTS INTO ACCOUNT. IT IS SIMPLY A DATA GAP ANALYSIS. THIS IS A FUTURE 
AREA FOR IMPROVEMENT DEPENDING ON SUCCESS/EFFICIENCY OF FIRST PHASE.  
 
To create the confidence grid you will need the following:-  

• ArcGIS (with a Spatial Analyst extension) 

• Shapefiles/Feature Classes of the following: samples, separate seismic and 
side scan sonar survey track lines, multibeam extent polygons and a polygon 
of your project/territorial area. 

• A relatively experienced ArcGIS user  

• International phone line to call Rhys for help. 

1.  Sample Density 

The sample density was calculated using the Point Density function of ArcGIS Spatial 
Analyst. The density of samples is calculated for a specified area around the centroid 
of each output raster cell. The specified search area used to calculate density is 
determined by the total size of study area.  The number of points falling within the 
search area is totalled and divided by the search area. The resulting grid was then 
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reclassified to assign an appropriate score (1-3) for inclusion in the final confidence 
grid. For example, a 4km2 search area is used: 0-0.24 = 1 (no samples); 0.25 – 0.5 = 2 
(between 1 and 2 samples); > 0.5 = 3 (more than 2 samples). 

1.1 METHOD 

1.1.1 Open ArcMap in a suitable projection for study area/territorial water. The 
final grid has a cell size of 1km so a projection must be used (preferably WGS 84 and 
appropriate UTM zone) > 
1.1.2 Add seabed samples used in interpretation> 
1.1.3 Make sure you set the extent of the grid to be a sensible number. Lower the 
extent to nearest kilometre.  
Open Spatial Analyst toolbar > Options > Extent > Set Analysis Extent to a 
shapefile/feature class of your project area. Then lower the left and bottom extent 
values to the nearest whole kilometre. 
1.1.4 Open ArcToolBox>Spatial Analyst Tools>Density>Point Density 
1.1.5 Input Point Features - Your samples feature class, Population field - NONE, 
Output Raster - Specify output  Output cell size = 1km, Neighbourhood – Rectangle, 
Neighbourhood Settings –Height – 2000, Width – 2000. Units – Map. 
1.1.6  Open Spatial Analyst Toolbar>Reclassify>Select input raster and specify 
field>Set values to reclassify 0-0.24 = 1, 0.25 – 0.5 = 2, > 0.5 = 3 > specify output 
raster. 
NOTE – Feel free to change values to suit your study area. 

2. Survey Tracks 

Survey track plots were converted into a 1km grid and assigned a score of 1 (low 
frequency seismic was not included). 

2.1 METHOD 

2.1.1 Open Attribute table for track lines > Add a new numeric field > Right click new 
field header > Field Calculator > Apply a score of 1 to all track line features 
2.1.2 Open Spatial Analyst toolbar > Convert >Features to RASTER (NOTE: see point 
1.1.3 to ensure all grids produced have the same origin/extent) 
2.1.3 Features to Raster> Input Features – Your Track Shapefile > Field - specify 
numeric field created above. 
2.1.4 Reclassify all null values into 0. This is essential for later steps when the grids 
are summed.  >Reclassify > Old Values – New Values > No Data – 0, 1- 1  >Save New 
Raster  
 
Multibeam 
Follow the same method for above using a multibeam extents polygon, only this 
time assign a score of 3. 
Remember to reclassify NoData to a 0. 

Side Scan Sonar 

Follow the same method for above for track lines where the equipment type used 
was Side Scan Sonar. Apply a score of 1 
Remember to reclassify NoData to a 0. 
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FINAL CONFIDENCE GRID 

Use ArcMap>Spatial Analyst>Raster Calculator to sum all the intermediate grids 
created above into one final grid.  
 


